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Kroll Minor Ailments 

Introduction 

The pharmacist’s scope of practice in many provinces includes the ability to assess and then prescribe 

appropriate therapy for patients who present with one or more of the Minor Ailment conditions listed as being 

approved.  This document outlines the steps to follow when managing a patient encounter for a Minor Ailment 

assessment using the Kroll Minor Ailments module. 

Store Configuration options that affect the Minor Ailment module 

For the pharmacy team member who has the proper permissions: 

From the Start screen: 

Click File > Configuration > Store > Rx > 7-Counselling. 
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Two configuration options impact the Minor Ailment module: 

■ Require electronic signature for finalize 

Other (Med Reviews, Minor Ailments, etc.) 

If your system supports Electronic signature capture, click on this option. 

■ Minor Ailments 

In last X months 

X represents how far Kroll will go back in the patient profile to select medications to be sent to 

RxConsultAction. NOTE: The default is 3 months. 

Initiating the Minor Ailment session 

The Minor Ailment tool can be initiated from one of two places: 

■ From an appointment record with Type = Minor Ailment Consultation. Click Launch Service when ready to 

start. 

 

■ From the Professional Services area of the patient card. Click Ins and select Minor Ailment. 
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Using the Tool 

Once you have initiated the module, you will be presented with the Minor-Ailment-Select Data for Review screen.  

This screen notes medications in the patient’s profile (based on the Store Configuration option) along with any 

drug allergies noted and medical conditions noted. Click on each tab to review the information noted. This 

information will be sent to the RxConsultAction tool. 
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Click OK. 

The RxConsultAction screen displays. 

 

Click on the Minor Ailments tab. The list of available Minor Ailments will display. Click on the Minor Ailment that 

the patient is seeing you for. 



 
 

Kroll Minor Ailments 6 

 

The Minor Ailment form displays. 

 

This information 

is sent over and 

displayed for you. 
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Check that you have received consent from the patient. 

Click on the down arrow on the Means of Communication field and select how the service will be delivered. 

NOTE: This is how Kroll will know what Fee for Service drug card to select when creating the Fee for 

Service prescription record. 

The rest of the form is now accessible. Complete each section. 

 

If a prescription is warranted, click Add in the Prescribe section. 

Document the signs and symptoms 

that the patient is experiencing. 

Document other factors being 

experienced by the patient if 

applicable. 

Document whether the patient is 

experiencing signs or symptoms 

that may suggest another issue. 
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The Medication Selection screen displays. This screen will display the items included within the therapeutic 

category approved for the Minor Ailment. 
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Scroll down and click on the drug that you wish to prescribe. The list of brands will display. 

NOTE: The green checkmark indicates a brand covered by Ontario Drug Benefit.  A red circle with the 

strikethrough indicates a brand NOT covered by Ontario Drug Benefit.  An orange circle with an 

exclamation point indicates a brand with restricted coverage with Ontario Drug Benefit. 
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Click on the brand that you wish to prescribe. The prescribe screen will appear with the necessary fields 

prepopulated.  If you wish, you have the ability to add or modify the information. 
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If a referral is warranted as well, Click Add in the Refer section.   
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Click on the arrow on the Refer to field and select the Health care provider who is to receive the referral. 

Click on the box to include the consultation summary. 

Key enter the rationale behind the referral in the free form field. 

Click Conclude Intervention. 

If no referral is required, simply click Conclude intervention after reviewing the prescription details. 

The Document Management screen displays. 
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Under the Professional section on the left, click + adjacent to the Recipient field. The Addition of a Recipient 

screen displays.  
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Click the down arrow on the Quick selection of a prescriber field. A list of the prescribers who prescribed the 

prescriptions that displayed within this tool will appear.  Select the prescriber that you wish to send the notification 

to. 

The screen will be auto populated with the necessary information for the selected recipient. 

 

Click Save. 
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Under the Patient section on the right, the Referral (if a referral has been set up) and the Prescription will be 

checked automatically. If you want to generate a supplemental document to hand to the patient, click on the 

desired document(s). 
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NOTE: The Claim Service will be checked by default.  If you know that the patient has exceeded their 

annual limit, you may choose to uncheck this option. This results in Kroll NOT creating a Fee for Service 

claim. 

When complete, scroll down and click Finish and Save. 
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Information from Rx ConsultAction will then be sent to Kroll 

The documentation will automatically print. NOTE: if you are using the integrated Kroll Fax module, the 

prescriber notification will automatically be sent to Kroll Fax and sent to the Prescriber. 

The Minor Ailment Screen will display. 
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You are presented with a number of options: 

■ Dispense Now – Kroll will automatically create the prescription record and display it for you to review. 

■ Unfill – Kroll will automatically create the prescription record with the Unfill status noted 

■ Queue for Later – Kroll will automatically create the prescription record and place it in the ToDo queue 

■ Print for patient to take elsewhere – Kroll will NOT create a prescription record, however it will print the 

prescription that you would then sign and hand to the patient.  This is used when the patient has indicated 

that they wish to have the prescription filled somewhere else. 

■ View summary – When selected, the consultation summary is displayed. 
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Click Finalize and Claim Fee 

If Electronic Signature capture is enabled, you will be prompted for your signature.  If it is not activated, you will 

physically sign the document generated and scan it back into Kroll using the Document Scan utility. 
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The fee for service F12 screen will display with the correct Drug card preselected. 

 

Key enter MINOR AILMENT into the SIG field. 

Click F12-Fill Rx to continue and process the Fee for Service claim OR click Cancel which will place the record 

into the ToDo queue to be processed at a later time. 

Once the Fee for Service claim has been completed (or moved to the ToDo queue), the F12 screen with the 

prescription details will display. 
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The image of the prescription will be automatically saved to the prescription record. To view, click the Images tab 

in the lower left section of the record and then click the blue View Image hyperlink. 
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Click Close. 

When you are ready, click F12 - Fill Rx to continue. 
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The Patient Card 

Whenever a Minor Ailment session has been initiated, Kroll will automatically create a Minor Ailment line item in 

the Professional Services history section of the patient card. 

 

Column Headers: 

■ Type – the type of Minor Ailment  

■ Status – indicates the status of the encounter record 

■ Fee Status – notes if the Fee for Service claim has been paid 

■ Created – the date the record was created 

■ Completed – the date the record was completed 

■ Follow ups – will note follow up created (Phase 2) 

■ Started by – initials of the person on the terminal when the record was started 

■ Completed by – initials of the person on the terminal when the record was completed 
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■ Provided by – name of the pharmacist who conducted the consultation 

■ Drug(s) – drug(s) prescribed during the consultation 

To view the details of the professional service record, highlight the desired line item and click or press F2. 

 

The information noted in the Brown coloured header is similar to the column headers in the Professional Service 

history. It also includes details of the Fee for Service claim: specifically, the status, who processed the claim, the 

date it was processed, the Rx number of the claim, the Fee and the intervention code included. 

The documents generated can be viewed by clicking on the tabs. 

■ Tab with the Date and time – displays the complete consultation summary document 
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■ Referral Form - Physician tab (NOTE: If the referral is intended for another healthcare provider, that 

healthcare provider will be noted). The referral form displays. 
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■ Prescription tab-displays the prescription 
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■ Service Summary (prescriber’s name) tab– displays what is to be or was sent to the Prescriber 
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You are able to print any of these forms. Display the form that you wish to print by clicking on the appropriate tab 

and then click on the Printer icon located in the upper left corner. 
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Quick Minor Ailments FAQs 

Do I need to have Electronic Medication Reviews enabled in my Store Configurations for Minor 
Ailments? 

No. Electronic Medication Reviews do not need to be enabled to use the Minor Ailments module.  

What information and fields need to exist before I launch a Minor Ailments Professional Service? 

The following is required as part of using the Minor Ailments Module. Prior to launching the Minor Ailments tool, 

ensure that the following is entered: 

■ Patient: First Name, Last Name, Address, City, Province, Postal Code, Birthdate and Gender (M/F) 

■ Store Information (File > Configuration > Store): Store Name, Address, City, Province, Postal Code and 

Phone Number 

■ Pharmacist (Edit > Users and Groups): First Name, Last Name, Type = Pharmacist and License 1 

■ If not yet created, a Doctor card will be required for the Pharmacist, where the Designation = Pharmacist 

■ Patient Family Doctor and Rx Doctors: First Name, Last Name, Designation and License 

If any of the above information is not included, the RxConsultAction component of the module will display an 

error. 

Can Licensed Technicians or Pharmacy Assistants use the Minor Ailments tool? 

As per the Ontario College of Pharmacists, only Part A Pharmacists, registered pharmacy students and 

pharmacist interns are able to provide minor ailment services. 

Why am I prompted to select prescriptions before launching the Minor Ailments tool? 

The prescription selection provides the Pharmacist the opportunity to easily view patient prescription information 

within the Minor Ailments/RxConsult tool. 

How do I know if I am eligible to submit a claim for the Minor Ailment Fee for Service? 

The Ontario Ministry has set maximums to the number of claims that can be submitted for each category of Minor 

Ailments in a 365 day period. The values are available in the following link (pages 5 and 6). 

https://www.health.gov.on.ca/en/pro/programs/drugs/opdp_eo/notices/exec_office_eligibility_20221222.pdf 

https://www.health.gov.on.ca/en/pro/programs/drugs/opdp_eo/notices/exec_office_eligibility_20221222.pdf
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I have Advanced/Paperless workflow configured in Kroll. Does the Fee for Service claim go 
through my workflow? 

A Minor Ailments Fee for Service claim will move through your workflow the same way a Medication Review Fee 

for Service claim currently does. If you wish to have adjustments to how your Fee for Service claims are 

processed through Workflow, please reach out to our Kroll Customer Experience team. 

I don’t have a signature pad. How do I sign the prescription? 

If you do not have a physical signature pad, or the Kroll Virtual Signature module, the necessary documentation 

will print for the Pharmacist to sign physically, and can then be scanned into Kroll. 

Why didn’t the Rx image save automatically for the new prescribed medication?  

As signatures are required for authorized prescriptions, Kroll will only save the Rx image if an electronic signature 

is being captured as part of the Minor Ailments tool. If you have electronic signatures available in Kroll, go to File 

> Configuration > Store > Rx > Counseling and enable “Require electronic signature for: Other”. If you are 

interested in electronic signature capture options, please speak with our Sales team. 

How do I reprint documents? 

Return to the Professional Services section of the Patient card. Select the Minor Ailments entry and press F2. 

Each document generated will have a tab. Each tab has a printer icon, which will allow you to re-print the 

document. 

Is there a report for how many Minor Ailment encounters I’ve done? 

The Expanded Scope of Practice Report (Rx report) will provide you with a count of the Professional Services 

provided by Pharmacy User.  The Rx for Drug/Doctor Groups Report will provide detail of the Fee for Service 

claims when the PseudoDIN drug cards are added under the Drug section of the report set up screen.  There are 

plans to provide a more comprehensive report in the near future. 

When the tool is launched, I am seeing a second tab entitled Other Services.  What is that used 
for? 

If you plan on prescribing Paxlovid to a patient who requires it, select Other Services and select COVID-19-

treatment (Paxlovid). The system will walk you through a process similar to Minor Ailments. 
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Sample of the supplementary printout for the patient 

Below are samples of the two patient printouts for the example used in this user guide 
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